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Important information

N WARNING

o Failure to follow the installation instructions included with your SMART product could
result in personal injury and damage to the product.

o Ensure that any cables extending across the floor to your SMART product are properly
bundled and marked to avoid a trip hazard.

o Toreduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

o Do not push foreign objects into the openings on your SMART product.

e Do not open or disassemble the SMART product. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids your warranty.

e The camera arm on your SMART product has joints that present a pinch hazard when you
move the camera arm. Keep clear of the pinch points.

o Do not stare into the light or shine the light directly into someone’s eyes. Turn off the light
when displaying or capturing images of people.

o Do not overload power sockets or extension cords as this can result in a fire or electric
shock.

o Turn off and disconnect your SMART product before a thunderstorm. During a
thunderstorm, do not touch your SMART product or the power plug, because there is a risk
of electrical shock.

o Only use your SMART product with the type of power source that is written on the power
supply and do not modify the plug.

'Y CAUTION
o Place your SMART product on a solid surface to prevent it from falling.

o If you have a security cable attached to our SMART product, do not carry or swing your
SMART product by the security cable.



IMPORTANT INFORMATION

Do not connect non-shielded interface cables to your SMART product and do not leave
cables connected to unused connectors, because this can cause interference levels that
exceed FCC regulations.

Avoid setting up and using the SMART product in an area with excessive levels of dust,
humidity and smoke.

Do not block or cover the openings or slots on your SMART product. These slots provide
ventilation, ensure reliable operation and protect your SMART product from overheating.

Do not carry your SMART product by the camera arm. Carry it by the base of the unit.
Do not aim the camera lens at the sun.

If your SMART product requires replacement parts, make sure that the service technician
uses replacement parts specified by SMART Technologies or parts with the same
characteristics as the original.



Contents

Important information il i
Chapter 1: OVerVieW ... L 1
INtrOdUCHION L 1
Document camera features . ... 2
Parts of the document camera ... ... 3
Document camera modes ... .. L 8
Document camera software .. ... 9
Chapter 2: Setting up your SMART DocumentCamera ....................................... 11
INtrOdUCHION L 11
Setting up your document camera ... 12
Connecting your document camera to different displays ... ... ... 13
Turning your document cameraonand off ... ... . ... ... 15
Connecting your document camera to external devices ... ... ... 15

Shooting area, overhead light and anti-glare sheet ... . . .. . ... 18

External memory Storage ..o 20
Chapter 3: Using your SMART Document Camera ... ... ..o . 21
INErOAUC T ON L 21
Understanding Camera, Computer Pass-Through and Playback modes .................... 21
Identifying features of each mode ... ... 22
Setting document cameramodes ... 24

Displaying printed documents . ... .. ... .., 24

Inserting and removingan SD/SDHC card ... ... .. 25
Chapter 4: Using your SMART Document Camerain Cameramode ... . ... . ... 27
INtrOdUCHION L 27
UsingCameramode ............ e 27
Using the on-screen display (OSD) menuin Cameramode _...... ... 28
Capturing and transferring images and videos ... ... ... ... 38
USING @ MICTOSCOPE .. ... 40

Chapter 5: Using your SMART Document Camera with SMART Notebook software .... 41

Using your document camera with SMART Notebook software ... .................. 41
Chapter 6: Using your SMART Document Camera in Playback mode ...................._. 45
INtrOdUCHION L 45
Setting your document camera to Playback mode ... .. . ... 45
Using the Playback mode on-screen display (OSD)menu ... ... ... ............... 46
Playback mode OSD MEeNU ... . 46

Deletingimages in Playback mode __ ... ... 50



CONTENTS

Chapter 7: Using 3D Tools for SMART Notebook software and Mixed Reality Tools ....53

INErOAUC T ON L 53
Incorporating 3D content into yourlessons ...l 54
Getting started with Mixed Reality Tools for SMART Document Camera ..__............._. 54
Inserting and manipulating 3D models ... ... 56
Using Mixed Reality Tools for SMART Document Camera ................................... 62
Using SketchUp sketching software and Trimble 3D Warehouse ............................ 65
Chapter 8: Troubleshooting ... . ... 67
Document camera iSSUES .. ... .. . .. 67
Appendix A: Hardware environmental compliance ... ... . ... ... 7
Waste Electrical and Electronic Equipment regulations (WEEE directive) .................. 7
Restriction of Certain Hazardous Substances (RoHS directive) ............................. 71
Packaging .. ...l 7
I OX L 73



Chapter 1
Overview

OUIPULINPUL
Physical construction .. ... ..
SOt WaANe il
Image and video storage
Parts of the document camera ... ...
Adjustable camera arm and camera head
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Document camera modes

Your document camera 450 can transform any classroom or lecture hall into a spontaneous and
interactive learning environment. It uses a high-resolution video camera to display clear and
detailed images of written material or any physical object.

Your SMART Document Camera™ 450 enables you to display printed documents, microscope
slides and 3D objects on your computer, projector or television. You can record videos, scan
documents, capture images and save them to a SMART Notebook ™ collaborative learning
software file or to an SD/SDHC card or USB drive.
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Y our document camera integrates with SMART Notebook software and SMART Board®
interactive whiteboards, creating an interactive presentation environment.

You can use the mixed reality cube with your document camera to manipulate 3D models in
SMART Notebook files.

Camera
¢ High resolution 5 MP CMOS sensor

e 8x optical zoom, 8x digital zoom

¢ Internal memory

e Upto 30 frames per second

o Automatic or manual focus

e Maximum shooting area 40cm x 30cm (15 3/4" x 11 3/4")

e Microphone integrated into base

Microscope mode that requires adapters

Output/input
o VGA and DVI- outputs XGA (1024 x 768), SXGA (1280 x 1024), 720p (1280 x 720), 1080p
(1920 x 1080)

e Composite video output with user-selectable NTSC or PAL formats

e RGB (VGA)input (when selected by the user) is a pass-through to the VGA output.

Physical construction
e Security lock slot

o Flexible arm

o Bright LED overhead light

Software
e SMART Notebook software 11 or later, including 3D Tools for SMART Notebook software
and Mixed Reality Tools software.

¢ SMART Product Drivers
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Image and video storage
e Supports SD/SDHC cards with a built-in card slot (up to 32 GB, speed glass 4).

e Supports USB drivers.

e Supports USB mass storage mode for internal memory and SD card when connected to a
compulter.

Adjustable camera arm and camera head
You can fold and adjust the flexible arm to position the lens at any angle. The camera head has a
bright LED overhead light to enhance the lighting condition.

— 1 Camerahead
2 Cameralens

3 Overhead light

4 Flexible arm

5 Control panel

Control panel

You can use the control panel to switch between Camera, Computer Pass-Through and
Playback modes. You can also use it to control features and settings in the Camera mode's on-
screen display menu.

SION-SIcIOs

L 12

13
567

Button
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1 Select/Enter

2 Menu

3 Record video

4 Power on/off 10

5 Select camera 1
Select t -

5 elect computer pass 12
through

13

Select playback
Overhead light on/off
Image brightness
Zoom in/out

Auto-focus
Capture to SMART Notebook software or to local memory

USB indicator: computer or USB drive

For information on the different modes, see Understanding Camera, Computer Pass-Through and

Playback modes on page 21.
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Rear connection panel
The rear connection panel has DC 12V 2A, VGA In, VGA Out, Composite Video Out and USB
mini-B connectors.

Connect the power cable
Connect a VGA output connector of a computer
Connect any display device with a VGA cable

Connect the supplied composite video adapter cable

a A WO N -

Connect a USB connector of a computer

Left-side connection panel
The left-side connection panel has a DVI output, a switch for selecting either a computer ora
USB drive, and audio in and out connect.

Connect any display device with a DVI cable
USB switch

Connect a USB drive

Connect an external microphone

a A WO N -

Connect speakers for video playback only
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Right-side connection panel
The right-side connection panel has an SD/SDHC card slot, a switch for selecting VGA-DVI or
composite video output and a security lock slot.

-

(—— M— | |

TVVGA

N —rfE]

1 Camera head storage
2 SD/SDHC card slot
3 TV/IVGA switch

4 Security lock slot

Bottom control panel

The NTSC/PAL switch is on the bottom control panel. This switch enables you to change the
format of the composite video output for your television. Changes to the selected video output
take effect the next time you turn on your document camera. The resolution reset button resets
the output VGA/DV!I resolution to XGA.

NOTE

You can press the resolution reset button with a pen tip. Pressing the button for three seconds
resets the output VGA/DVI resolution to 1024 x 768.

e

[ 0

ANENNISEENNNN
s

1 NTSC/PAL switch
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2 Resolution reset button

Mixed reality cube
With a mixed reality cube, you can interact with 3D models in SMART Notebook software using

Mixed Reality Tools. See Using 3D Tools for SMART Notebook software and Mixed Reality
Tools on page 53.

Power supply

Y our document camera comes with a power supply, including a country-specific connector that
connects to the external power supply. Plug adapters for North America, Great Britain, Europe
and Australia are provided.

USB cable

Use the USB cable to connect your document camera to your computer. You can display
objects, capture images to SMART Notebook files and control your document camera from
SMART Notebook software.

VGA cable

Use the VGA cable to connect your document camera to a computer, projector or display. You
can display objects and capture images and videos to a storage device.

Composite video adapter cable

Use the composite video adapter cable to connect your document camera to a projector or a
display. You can display objects, capture images and videos to a storage device and use the
features in the on-screen menus.

NOTE

The provided DB9 connector isn’'t needed in any of the connection configurations.

Microscope adapter

Your document camera comes with a microscope adapter and two different sized rubber couplers
to fit the microscope eyepiece. With a microscope you can examine microscopic objects on a big
screen.

Anti-glare sheet
Place the anti-glare sheet over printed documents to reduce glare.
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Your document camera has three modes you can use to control how it sends data to a computer,
projector, monitor or television.

o Camera mode controls your document camera from its control panel and displays images on
a projector, monitor or television.

o Computer Pass-Through mode displays the image from the VGA input on a projector,
monitor or television connected to the VGA output.

o Playback mode controls your document camera from its control panel and displays images

from an SD/SDHC card or USB drive on a connected projector, monitor or television.

See Understanding Camera, Computer Pass-Through and Playback modes on page 21 for more
information on these modes.
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Y our document camera includes software downloads that you need to present images from your
document camera.

SMART Notebook software and SMART Product Drivers

Y our document camera uses SMART Notebook software and SMART Product Drivers.

SMART Notebook software is presentation software designed to work with

SMART Document Cameras and the touch features of SMART Board interactive whiteboards. In
addition, with a mixed reality cube, you can manipulate 3D models in SMART Notebook files
using Mixed Reality Collaboration tools (see Using 3D Tools for SMART Notebook software and
Mixed Reality Tools on page 53).

You can find system requirements for your computer in the SMART Notebook software 11.1
release notes (smarttech.com/kb/170138).

IMPORTANT

You need to have SMART Notebook software 11 SP1 or later installed on your computer before
you connect your document camera.

Downloading software

To install SMART Notebook software and SMART Product Drivers

1. Go to smarttech.com/software.

2. Scroll to SMART Notebook collaborative learning software.

3. Click Choose a version, select the latest version of SMART Notebook software for
Windows® or Mac and then follow the on-screen instructions.


http://www2.smarttech.com/kbdoc/170138
http://www.smarttech.com/software
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This chapter explains how to set up your document camera and how to connect with different
displays and devices. It also explains external memory storage usage.

11
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The document camera has a flexible arm with rotational movement for easy positioning display
objects.

To unfold and position your document camera
1. Place a hand on the base of the document camera to stabilise it.

2. Press the camera head down and then pull the camera arm outward and upward.

IMPORTANT

To use your document camera with SMART Notebook software you need to connect your
document camera to a computer.

To connect the power supply
1. Connect the power supply cable to the DC 12V port on the rear connection panel.

2. Connect a country-specific connector to the power supply.

12
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'Y CAUTION

Ensure that you connect the power connector to the power supply before connecting the
power plug to a power socket.

4. Connect the plug to a power socket.

To use your document camera in Camera or Playback mode, connect your document camera
directly to an external display.

To connect your document camera to a computer with a USB cable
1. Set the USB switch on the left side connection panel to @' =

The ¥ indicator on the control panel lights up, and you can use your document camera
as a USB camera or to transfer captured pictures/videos from the memory source to your

compulter.
2. Connect a USB cable to the USB port on the rear connection panel.

3. Locate the USB connector on your computer and then connect the cable to it.

To connect your document camera to a computer with a VGA cable
1. Connect a VGA cable to the VGA In port on the rear connection panel.

2. Locate the VGA Out connector on your computer and then connect the cable to it.

Once you have completed the basic connection procedure, you can connect your document
camera to an external display. This enables you to use the document camera in Camera mode
and Playback mode (see page 21) and to access the on-screen display menu for those modes.

You can connect your document camera directly to an external display to enable the following
functions:

¢ Use Camera mode to view the camera image in full-screen on the external display.

o Use Playback mode to view a full-screen slide show on the external display.

IMPORTANT

To use your document camera with SMART Notebook software you need to connect your
document camera to a computer.

13
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Setting the TV/VGA switch
10

The TV/VGA switch determines the display output selection. Set it to VGA (right)tvivea when

I
using a VGA or DVI connection for a signal output. Set it to TV (left)viwea when using an RCA
connection for a composite output.

Connecting your document camera to a monitor or a projector
In this configuration your document camera is connected to your external display device with a

VGA cable.

To connect your document camera to a monitor or a projector

1. Complete the basic connection steps (see page 12).

IMPORTANT
Make sure that the TV/VGA switch is set to VGA .

2. Connect a VGA cable to your document camera's VGA Out port and your display
device'sVGA In connector.

Connecting your document camera to a monitor or a projector with a
DVl interface

In this configuration your document camera is connected to your external display device with a
DVI cable (not supplied).

To connect your document camera to a monitor or a projector with a DVI interface

1. Complete the basic connection steps (see page 12).

IMPORTANT
Make sure that the TV/VGA switch is set to VGA .
2. Connect a DVI cable to your document camera's DVI Out port and your monitor's or
projector'sDVI Input connector.
3. Connect your document camera to an external display with a VGA cable (see page 15).

This configuration makes it easy to transition from Computer Pass-Through mode to
Camera mode or Playback mode using the same projector or display for all three modes.

Connecting your document camera to a TV or a projector
In this configuration your document camera is connected to your computer with both a composite
video adapter cable and an RCA cable.

14



CHAPTER 2
Setting up your SMART Document Camera

To connect your document camera to a TV or a projector
1. Complete the basic connection steps (see page 12).

2. Connect a composite video adapter cable to your document camera's Composite Video
port.

3. Connect an RCA cable to your display's Video In connector.

4. Connect the composite video adapter and the RCA cables (see page 15).

IMPORTANT

Do not connect the 9-pin cable i

DVI or composite video displays will not display your computer view. A VGA display is
required.

To turn on your document camera

|
Press the power button on the control panel.

The power light changes from amber to flashing green. When the light is solid green, your
document camera is operational.

To turn off your document camera

|
Press the power button on the control panel.

The power light changes from green to amber.

You can connect your document camera directly to the following external devices:
e Microscope
e Microphone

e Speakers

15
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Connecting your document camera to a microscope
You can connect your document camera to a microscope. This enables you to examine

microscopic objects on a big screen.

To set up a microscope
1. Select the appropriate rubber coupler size for the microscope eyepiece and insert it in the

microscope adapter.

~e®

2. Attach the microscope adapter to your document camera's camera head and then connect it

to your document camera.

3. Tighten the three bolts until the adapter secures the eyepiece.

16
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4. Fit the camera head with the microscope adapter over the microscope's eyepiece.

IMPORTANT

Make sure that the arrow on the camera head and microscope adapter are on the same
side.

5. Turn the microscope adapter anticlockwise to line up the arrows and lock the microscope
adapter in place.

To connect the microscope to a projector or a display

1. Pressthe button on the control panel and then select the tab.

= )
2. Use the /=X button on the control panel to selectMODE and then press thel”—\ button on
the control panel.

S—% 7
3. Usethe % button on the control panel to select and then press theDQ@ button on the
control panel.

4. Pressthe button on the control panel to close the menu.

5. Connect the other end of the VGA cable to the VGA In connector on your projector or
display.

[l

6. Setthe VGA/TV switch on the right-side connection panel to VGAvvea.

Switching between VGA, DVI and composite output
If you're using a projector or a computer display with a VGA or a DVI cable, set your document
camera to the VGA mode. If you're using a television with the composite video cable, set your
document camera to the TV mode

17



CHAPTER 2

Setting up your SMART Document Camera

To set your document camera to the VGA mode

Wl
Set the VGA/TV switch on the right-side connection panel to VGAvea.

To set your document camera to the TV mode

m
Set the VGA/TV switch on the right-side connection panel to TV.

Connecting your document camera to an external microphone
You can connect an external microphone to your document camera.

NOTES

o The built-in microphone on the control panel is disabled when an external microphone is
connected.

e The audio is in monophonic sound.

To connect an external microphone to your document camera

Connect the microphone's cable to the microphone on your document camera's left-side
connection panel.

Connecting your document camera to speakers
You can connect speakers to your document camera. Only audio from the video playback is
supported.

'Yf cAuTION

Turn the volume down to prevent hearing damage when using earphones.

To connect speakers

Connect the speakers’ 3.5 mm cable to the speaker port on your document camera's left-
side connection panel.

Shooting area
The shooting area can view a maximum area of 40cm x 30cm (15 3/4" x 11 3/4").

18
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To rotate the image

1. Pressthe @ button on the control panel.
S

2. Press the Dg@ button on the control panel and then select i
S—7

3. Pressthe DQ@ button on the control panel.
S—7

4. Pressthe DQDQ button on the control panel and then selectROTATE.
S

5. Pressthe DQ@ button on the control panel.

N7
6. Select rotation range and then press the DQ@ button on the control panel.

7. Pressthe @ button on the control panel to close the menu.

To mirror the image
1. Pressthe ﬂ button on the control panel.
S 2
2. Pressthe DQDQ button on the control panel and then select .
=
3. Press the I/ button on the control panel.
i
4. Press the l&®)J button on the control panel and then selectMIRROR.
=
5. Press the /) button on the control panel.
[
6. Select ON orOFF and then press thel~—\) button on the control panel.
7. Pressthe ﬂ button on the control panel to close the menu.

Overhead light

Press the button on your document camera's control panel to turn the overhead light on or
off.

Anti-glare sheet

The anti-glare sheet is a special coated film that helps to eliminate any glare that could be
encountered whilst displaying glossy objects, such as magazines and photos. Place the anti-
glare sheet on top of the object to reduce reflected light.

19
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Y our document camera supports both an SD/SDHC card and a USB drive for image capture,
audio and video recordings. Your document camera detects when an external storage device is
connected and automatically switches to the last detected storage. If no external storage device
is connected, all captured images are saved in the built-in memory.

IMPORTANT

Your document camera comes with piece of plastic inserted in the SD card slot. Remove this
piece of plastic before you insert your SD/SDHC card.

NOTES
e Your document camera supports SD/SDHC cards with up to 32 GB, speed class 10.
o SDHC card with class-6 or higher is recommended for high-quality recording.

e Pushinthe SD/SDHC card to eject it.

To connect a USB drive

1. Set the USB switch on the left-side connection panel to <8

Your document camera detects the USB drive and the & indicator on the control panel
lights up.

2. Insert the USB drive into the USB port.

NOTES

Your document camera supports USB drives with up to 64 GB.

20
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This chapter provides information about your document camera's different modes.

You can use your document camera in Camera, Computer Pass-Through or Playback mode.
Each mode enables you to complete different functions and requires a specific connection to
either a display, a projector or a computer.

Camera mode
In Camera mode, you can view document camera images only in SMART Notebook software.

Camera mode allows connection over USB and live image output. You can view full-screen
images from your document camera using a projector or high-definition display without a
computer.

21
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You can save images to your SMART Notebook file to present them later, or if your computer is
connected to an interactive whiteboard, projector or television, you can deliver your
SMART Notebook presentation with live images from your document camera.

NOTE

The Capture button on the control panel saves the image to the Notebook page and closes the
SMART Document Camera window. Pressing the Capture button again will re-open the
SMART Document Camera window.

You can use the Camera mode’s on-screen display menu for greater control of the image.

See Using your SMART Document Camera in Camera mode on page 27.

Computer Pass-Through mode
Computer Pass-Through mode switches your document camera's video output to the VGA input.
You can switch between the live camera image and your computer screen image.

You can view the document camera live image only in SMART Notebook software.

NOTES
o Capture button on the control panel has no effect in Computer Pass-Through mode.

o In Computer Pass-Through mode, you can only view the document camera live image in
SMART Notebook software.

Playback mode

In Playback mode you can view full-screen images and slide shows from the memory card on a
projector or high-definition display without a computer. You can’t use your document camera as a
mass storage device in Playback mode.

The following table describes the differences between each mode.

Feature description Camera Computer Playback
mode Pass-Through mode

% mode
=]

View computer input (VGA In) No Yes (VGA out No
and DVI
analogue)

22
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Feature description Camera Computer Playback
mode Pass-Through mode
% mode B
View document camera image Yes No No
View pictures from a memory card No No Yes
Access an internal memory and SD/SDHC card ~ Yesl'] Yesl'] No
from the computer with a USB cable
Control the document camera from a computer Yes Yesl] No
Capture to SMART Notebook software Yes No No
Capture to an SD/SDHC memory card Yes No No
Access the related on-screen display menu Yes No Yes
Capture to a USB drive Yes [2] No No
NOTES

e [1] Only when the USB switchiis set to < See The Setting tab on page 35.
« [2] Only when the USB switch is set to *=8. See The Setting tab on page 35.

The following table describes outputs when your document camera is connected to a display with

VGA, DVI or Composite Video Out.

Feature description Camera Computer Playback
mode Pass-Through mode
% mode B
N
Connect to a projector or display (VGA Camera VGA In Memory
out and DVI analogue output) image card
images
Connect to a DVI digital output Camera N/A Memory
projector or a display image card
images
Connect to a television (composite Camera N/A Memory
video out) image card
images

23
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To set your document camera to Camera mode
1. Set your document camera to Computer mode (Ba g using the switch on the left-side

connection panel. The USB indicator on the control panel displays @%'C).

2. Connect your document camera to your computer with the USB cable.

[

3. Set the TV/VGA switch on the right-side connection panel to VGA tvivea.

4. Connect your document camera to a projector, monitor or television with a VGA cable.

5. Pressthe Q@ button on the control panel.

To set your document camera to Computer Pass-Through mode
1. Connect your document camera to your computer with the USB cable.
2. Connect your computer with the VGA cable to your document camera's VGA In port.

3. Connect your display device with another VGA cable to your document camera's VGA Out
port.

4. Pressthe button on the control panel.

To set your document camera to Playback mode
1. Disconnect the USB cable from the rear connection panel.

2. Connect your document camera to a projector or a monitor with the VGA cable or to a
television with the composite video adapter cable if needed.

3. Pressthe B button on the control panel.

When you set your document camera to Camera mode, you can display printed documents, use
the anti-glare sheet to reduce glare, and optimise the image for text and graphic documents with
the Image mode options.

To display printed documents
1. Place your documents on the table.

2. Adjust the document camera and then aim its lens at your documents.

3. Pressthe button on the control panel to adjust the focus.
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To reduce glare

If glare makes it difficult for you to read the printed documents that you're displaying, place
the anti-glare sheet on top of the printed documents.

To optimise the image for text documents

1.

Set your document camera to Camera mode.

Press the button on the control panel.

The on-screen display menu appears.

S—~% S—7
Press the M button on the control panel to select and then press theDQQ button on the
control panel.

= )=
Press the lz&\) button on the control panel to selectiIMAGE MODE and then press thelz\
button on the control panel.

S—~% - S—~
Press the M button on the control panel to select and then press theDQQ button on the
control panel.

See The Image tab on page 29 for an explanation of the settings.

To optimise the image for documents with graphics

1.

Set your document camera to Camera mode.

Press the button on the control panel.

The on-screen display menu appears.

S—~% S—7
Press the ng button on the control panel to select and then press theDQQ button on the
control panel.

= (]
Press the lz&) button on the control panel to selectiIMAGE MODE and the press thelz>
button on the control panel.

)= (]
Press the /=N button on the control panel to selectL®™=_] and then press thel~—\! button on the
control panel.

See The Image tab on page 29 for an explanation of the settings.

Your document camera has an SD/SDHC card slot on the right-side connection panel. You can
save document camera images to an SD/SDHC card when your document camera is in Camera
or Computer Pass-Through mode. When your document camera is in Playback mode you can
display previously captured images from an SD/SDHC card.
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'Y CAUTION

Avoid static electricity near a card because it can damage.

IMPORTANT

Your document camera comes with a piece of plastic inserted in the SD/SDHC card slot.
Remove this piece of plastic before you insert your SD/SDHC card.

To insert an SD/SDHC card

1. Pressthe “¥% button on the control panel.

2. Insert an SD/SDHC card into the card slot on the right-side connection panel with the
contact facing down.
IMPORTANT

e You might need to set your document camera to use the SD/SDHC card as the storage
location (see The Setting tab on page 35).

o Ensure that the label on the SD/SDHC card is facing up.

To remove an SD/SDHC card

'Y cCAUTION

To prevent memory card damage, do not remove the memory card whilst capturing or deleting
images.

1. Pressthe Q@ button on the control panel and wait until your document camera displays a
live image.

2. Pushinthe card to eject it and then remove the card.
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This chapter explains how to use your document camera in Camera mode.

When your SMART Document Camera is connected to a projector, flat-panel display or
television you can display a full-screen image from your document camera.

You can use your document camera in Camera mode to perform the following tasks:

Display objects.

Capture images to an SD/SDHC card.
e Capture images to SMART Notebook.
¢ Use the features and settings in the on-screen display menu.

¢ Use a microscope with a standard eyepiece with additional adapters.
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IMPORTANT

Your document camera must be connected directly to an external display when using the OSD
menu. See Connecting your document camera to external devices on page 15.

To switch to Camera mode

1. Connect your document camera to a projector or flat-panel display with the appropriate cable
(see Connecting your document camera to external devices on page 15).

2. Press the g?@ button on the control panel.

To display objects

1. Press the % button on the control panel.
2. Place the object you want to display under the camera.

3. Rotate the camera head to aim the lens at your object.

To adjust the zoom magnification

Press the button on the control panel.

To automatically adjust the focus

Press the button on the control panel.

To adjust brightness settings

Press the button on the control panel.

To record a video

1. Insert an SD/SDHC card or USB drive into the appropriate port.

2. Pressthe @ button on the control panel to start recording.

3. Pressthe @ button on the control panel to stop recording.

There are four tabs on the OSD menu: Image, Presentation, Setting and System. Use the OSD
menu to adjust settings for your document camera in Camera mode.

= R s [ o
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To navigate the OSD menu and submenus

1. Set your document camera to Camera mode.

2. Pressthe button on the control panel.
The OSD menu appears.

7 S—#
3. Pressthe D%Q andD%q buttons on the control panel to toggle between tabs.
S—7 =7
4. Pressthe % andDg@ buttons on the control panel to choose a selection in the menu list.
S—7
5. Pressthe DQQ button on the control panel to make a selection.
S—7
6. Pressthe DQQ button on the control panel to enter a submenu.
S—~
7. Pressthe DQQ button on the control panel to return to the previous menu level.
8. Pressthe button on the control panel to exit the menu.

The following OSD menu options are available when your document camera is in Camera mode.

Tab Options

Image Brightness, Contrast, Mode, Effect, Mirror, Advanced, Focus, Rotate.
See The Image tab below.

-| Presentation Picture in Picture (PiP), Split Screen, Timer. See The Presentation tab

on page 32.
Settings Capture, Recording, Storage, Format, USB to PC and Flicker.
!E’ System Language, Output Display, Backup, Save Setting, Recall Setting,

Information, Default.

The Image tab

To access the Image settings menu

1. Pressthe mﬂ’?‘ button on the control panel.
2. Pressthe button on the control panel.

)= D
3. Press the /=N button on the control panel to select and then press thel~—\J button on the
control panel.
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S—7 =7 S—7
4. Pressthe DRQ orD%Q button on the control panel to select and then press theDQ@ button
on the control panel.

Contrast
Hode

Effect Color

Hirror

Focus

Rotate

Image options Description

Brightness Adjust the image brightness manually.
Contrast Adjust the image contrast.

Mode Select an option from five image settings:

° Sharp — adjust the contrast to make text appear more
visible

o @ Graphics —adjust the image gradient

o Vel Motion — increase the frame rate (sufficient lighting is

required when using this setting)

o Macro — set when viewing an object that is close to
the camera, no more than 20cm (7 3/4") away from the

camera

(AN
° Infinite — set when viewing an object that is more
than 55cm (22") away from the camera

Effect Convert the image to colour, black/white or film negative
image.
Mirror Select toflip the image:

o OFF —displays a normal image
o ON —displays a mirrored image

Advanced

o Auto Image Select to automatically adjust white balance and exposure and
to correct colour and exposure compensation.
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Image options

Description

o Exposure

Select the exposure setting:

o AUTO - automatically adjust the camera exposure
o MANUAL — manually adjust the camera exposure

o White Balance

Select the white balance setting for various light conditions:
o AUTO - automatically adjust the white balance

o MANUAL — manually adjust the red and blue colour levels
up to 255.

Focus

Adjust the focus manually.

Rotate

o

OFF - displays normal image rotation
90° —rotates the image 90°

180° —rotates the image 180°

270° —rotates the image 270°

[e]

[¢]

[}
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The Presentation tab
Presentation features enable you to show previously captured images along with the live camera

view. These features aren't available when the document camera is connected as a USB
camera.
To access the Presentation tab

1. Pressthe % button on the control panel.

2. Pressthe button on the control panel.

S—~% S—7
3. Pressthe DRA button on the control panel to select and then press theDQQ button on the
control panel.

S—7 I—I S—7
4. Pressthe DRQ button on the control panel to select and then press theDQQ button on the
control panel.

PIF

Split Ecreen

Tilmzr
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Presentation options Description

Picture in Picture (PiP) o Shows captured pictures or video as thumbnails in corner
of the screen in Camera mode.

[e]

Press the left and right navigation buttons to navigate
through the stored images.

Press the button to cancel PiP.

[e]

[¢]

Split Screen Divides the screen in two parts.

Half of the screen displays thumbnail images and the
other half displays the image from your document
camera.

Select the display location: left, right, top, bottom.

= il

[}

[e]

o Press the left/right and up/down navigation buttons to
highlight the image.

[
o Press the /=) button to select the image.
e

issio oo A

o Press the left/right and up/down navigation buttons to pan
the stored image.

o Pressthe button to cancel split screen.
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Presentation options Description

NOTE

You can’t capture an image whilst in Split Screen mode.

Timer o Provides an on-screen countdown timer for a presenter to
assist with presentation time management.
00:59: 11

Using the Picture in Picture (PiP) feature
The PIP feature allows you to display an image from stored memory within the live camera
image. This is useful for showing before and after comparisons.

NOTE

The PiP feature is for display purposes only. You can’t capture an image whilst in PiP mode.

. To display the PiP image

1. Display an object in Camera mode and then press the button on the control panel.
The OSD menu appears.

S—# I—I S—7
2. Pressthe D&‘ button on the control panel to select and then press theDQQ button on the
control panel.

= =
3. Press the Iz button on the control panel to select PiP and then press thel~— button on the
control panel.
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S—7
4. Select the comer of the display and then press the DQQ button on the control panel.

Your document camera displays a picture in picture image.

000000

E(p—=
5. Press 7=\ and/—\ buttons on the control panel to choose different stored images.

The Setting tab

. To access the Setting tab
1. Pressthe o button on the control panel.
2. Pressthe button on the control panel.

S—~# S—7
3. Pressthe D&‘ button on the control panel to select and then press theDQQ button on the
control panel.

={( )=
4. Press the lz&/ button on the control panel to select and then press thel~—\J button on the
control panel.

SETTING

Capture = REsclution Quality

SR to PC

Flicker
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Settings options Description
Capture
o Resolution Select image capture size. In 5M setting, the capture

resolution is 2592 x 1944.

o Quality Select image quality; Finest, High, Normal.

o Type Select image capture type:

o Single — capture one picture at a time
o Continuous — capture consecutive pictures

o Interval Set the time interval for continuous capture. The length
can be set up to 600 sec (10 min).

Recording Select the video recording compression setting.

Storage Change the storage location:
o Audio and video recording can be saved only on an
SD/SDHC card, ora USB drive.

Format Delete all the data in the selected memory.

USB to PC Select the status of your document camera whenit’s
connected to the computer using a USB cable. Make sure
the USB switch on the left-side connection panel is set to

<
o Camera - can be used as a computer webcam, to
capture still images or to record a video
o Storage — transfer captured images or videos from
the memory to a computer hard drive

Flicker Select refresh rate:

o 50 Hz —sets frequency to 50 Hz
o 60 Hz —sets frequency to 60 Hz

Playback mode

Playback mode sets how your document camera, computer and a memory card interact.

To access the Playback mode

1. Pressthe % button on the control panel.
2. Pressthe button on the control panel.

S—~% S—7
3. Pressthe M button on the control panel to select and then press theDQQ button on the
control panel.

= )=
4. Press the l&&/ button on the control panel to select USB to PC and then press thel/—
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button on the control panel.

S—7
Select STORAGE and then press theDQQ button on the control panel.

Action Storage Camera
See the memory card from your computer Yes No
View and use your document camera from SMART Notebook No Yes
software

Capture image to the memory card in both Computer Pass- No Yes

Through and Camera modes

This mode enables you to see the contents of your USB drive or SD memory card from your

computer.

The mass storage mode enables you to see the contents of the embedded memory or SD/SDHC
card from your computer. They will show up as removable disks. Look in the document camera

DCIM directories for the stored images and videos.”

The System tab

To access the System menu

1. Connect your document camera to a projector, flat-panel display or television (see page 16).

2. Press the % button on the control panel.

3. Pressthe button on the control panel.
The OSD menu appears.

)= Ed =
4. Press the /=N button on the control panel to select and then press the'Zl button on the

control panel.

@I

Lan

Output D

Prafile 1 Pro

Profile 1 Fro

InfarmatLon

fefau Lt
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System options Description

Language Select or change the language:
o English
o Frangais
o Deutsch
o Espariol

Output Display Set the resolution to display an image on the screen:
o 1024 x 768
o 1280 x 1024
o 1280 % 720
o 1920 x 1080

NOTE

This selection disabled in TV output mode.

Backup o SD/SDHC - copy images and presentations from the
build-in memory to an SD/SDHC card
o USB drive — copy images and presentations from the
build-in memory to a USB drive

Save Settings Save the current setting in the selected profile number.
NOTE
Only effect, mode, brightness and contrast settings can
be saved.
Recall Settings Restore the setting to the selected profile number.
Information Display the product information.
Default Restore all the settings to the factory default settings.

You can capture images and videos from your document camera to an SD/SDHC card or USB
drive and transfer them to a computer.

Capturing images
You can capture images and videos to an SD/SDHC card or USB drive when your document
camera is in Camera mode.

To capture images to memory
1. Set your document camera to Camera mode. See Using Camera mode on page 27.

2. Position your document camera.
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3. Adjust any camera settings using the Camera mode’s OSD menu. See Using Camera mode
on page 27.

4. Pressthe button on the control panel.

To record a video using an SD/SDHC card

1. Insert an SD/SDHC card in your document camera's SD/SDHC card slot.

S—7
2. Pressthe button on the control panel to select-% and then press theDQQ button on the
control panel.

= (]
3. Press the 42/ to selectSTORAGE and then press thel~) button on the control panel.
The document camera detects the SD/SDHC card.

4. Pressthe @ button on the control panel to start recording.

NOTE
The video saves in .AVI format in your SD/SDHC card.

5. Pressthe @ button on the control panel to stop recording.

To record a video using a USB drive

1. Insert a USB drive in your document camera’s USB port.

= (]
2. Press the &) to selectSTORAGE and then press thel~~J button on the control panel.

The document camera detects the USB drive.

3. Pressthe @ button on the control panel to start recording.
NOTE

The video saves in .AVI format in your USB drive.

3. Pressthe @ button on the control panel to stop recording.

Transferring images to your computer
You can transfer images from your external storage device to your computer.
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To transfer images to your computer

1.
2.

Use the OSD menu to set your document camera USB to PC mode to STORAGE.

Connect your document camera to your computer with the USB cable (see Setting up your
document camera on page 12).

Your computer recognizes your document camera and the external storage device as a
removable disk.

Browse to the removable disk on your computer and then transfer the images to your
compulter.

You can view the microscope stage through the document camera using additional attachments.
See Connecting your document camera to external devices on page 15.

To display a microscope slide

1.
2.
3.

40

Place a slide or object on the stage of the microscope.
Focus the microscope so that the subject is in sharp focus.

Position the microscope under your document camera so the camera lens is aligned with the
microscope eyepiece.

'Y cAUTION

Ensure that you do not hit your document camera lens with the microscope. This could
damage your document camera’s lens.

Press the ~ ¥ button on the control panel.
Press the button on the control panel.

S—# S—7
Press the D%q button on the control panel to select and then press theDQ@ button on the
control panel.

)=q =
Press the &/ button on the control panel to selectMODE and then press thel/—\) button on
the control panel.

S—7 S—"
Press the M button on the control panel to select and then press theDQ@ button on the
control panel.
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Using your document camera with SMART Notebook software ... ... ............ 41

Using your document camera with
SMART Notebook software

You can display objects and capture an image to a SMART Notebook page.

You can present images from your document camera through SMART Notebook software. The
interactive whiteboard or projector displays your computer desktop or SMART Notebook file.

IMPORTANT

Your document camera should be in Camera mode. SMART Notebook software also works
with the camera in the Computer Pass-Through mode. See The Setting tab on page 35.

NOTE

For information on using 3D Tools for SMART Notebook software and Mixed Reality Tools for
SMART Document Camera, see Using 3D Tools for SMART Notebook software and Mixed
Reality Tools on page 53.

. To open a SMART Document Camera window

1. Connect your SMART Document Camera to your computer and turn on the document
camera.

2. Start SMART Notebook software.

3. Press SMART Document Camera Y on the SMART Notebook menu bar.

A SMART Document Camera window appears.
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4. Place the object or objects that you want to display under the camera.

SMART Diocument Camesa *

i fa oy | 2 @ e | 6] - 0 [E:3

5. Press any of the following on the menu bar to adjust the image.

Menu option Description

Zoom out.

Zoom in.

LARZIRO;

Decrease brightness.

B Increase brightness.

o Focus automatically.

e Focus out manually.

ot Focus in manually.

o] Change the appearance of the image: rotate it 180°, define the image
colour, black and white or film negative. You can also start and stop
Microscope mode and start Mixed Reality Tools for
SMART Document Camera automatically.

5 Start Mixed Reality.

(sl Insert a screen capture on the current page and then close the window.

i Capture an image and insert a screen capture on a new page and keep

the current window open.

. To take a series of screen captures

1. Open a SMART Document Camera window.

2. Press Capture with Time-Lapse nf"_é. on the SMART Document Camera window menu bar

and then select a period of time. (For example, if you want to take a screen capture every 15
seconds, select 15 Seconds.)
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3. When you've finished, press @ to stop recording.

NOTE

# 013 ©
The display appears in the bottom left-hand corner of your SMART Notebook
page. It displays the time that has lapsed since the last screen capture and the number of
screen captures taken.

To use a microscope

1. Connect your document camera to a microscope. See Connecting your document camera to
external devices on page 15.

2. Opena SMART Document Camera window.

3. Press Additional Settings %% on the SMART Document Camera window menu bar and
then select Start Microscope Mode.

NOTE

The Additional Settings ‘. button doesn'’t appear if you're using a
SMART Document Camera 230 with SMART Notebook software.

4. Press Additional Settings %4, and then select Stop Microscope Mode when you've
finished.
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Deletingimages in Playback mode . ... .. L 50

This chapter explains how you can use your document camera in Playback mode. When you set
your document camera to Playback mode, you can play back images from the SD/SDHC card,
USB drive or internal memory. You can browse through the stored images and display previously
captured images either individually or as a slide show.

NOTE

In this mode your document camera can’t be connected by a USB cable and you must have
images stored in either internal or external memory source.

Playback mode takes over the video output of the document camera. Live images and USB
functions are not available during this time.

To set Playback mode using an SD/SDHC card

1. Connect your document camera directly to a projector or another display. For connection
information, see page 13.
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2. Insert an SD/SDHC card in your document camera.

3. Pressthe Bbutton on the control panel.

. To set Playback mode using a USB drive

1. Connect your document camera directly to a projector or another display. For connection
information, see page 13.

2. Setthe USB switch to [*% 8. The USB indicator “* on the control panel is lit.

3. Pressthe Bbutton on the control panel.

Using the Playback mode on-screen display
(OSD) menu

The Playback mode OSD menu shows the source storage location and controls how stored

images are displayed.
Playback mode OSD menu options

. To access the Playback mode OSD menu

1. Connect your document camera directly to a projector or another display. For connection
information, see page 13

2. Setthe USB switch to [*% 8. The USB indicator ¥ on the control panel is lit.
OR

Disconnect the computer USB connection to change the memory location to the USB drive.

3. Pressthe button on the control panel.

Playback mode OSD menu

FLAYBACK
SLide Show o Run
Interval b |

A f
Effect M BV | == ¢

Current Storsge Enbtedeled S0 Cant BB D lve

Delete ALL EXECUTE
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Playback menu option Description

Slide Show Displays all captured still images in an automated slide show.

Interval Sets the slide show interval (in 5 second increments) before

displaying the next image. The maximum interval is 100 sec.

Effect Selects the slide show transition effect:

o n Slide image
o Checker down

o Wipedown
o EEE Split vertical out
o Split horizontal in

Current Storage Chooses the storage source if more than one is available. Detects

the storage source if only one is available.

Delete All Permanently deletes all the data in the selected memory source.

NOTE

A warning message appears. Select YES to continue or NO to
stop.

To select the settings for a slide show

4.

5.

Press the button on the control panel to access the Playback mode OSD menu.

L and X
Press the =) and\/=\l buttons on the control panel to make a selection and then press the

[Qj button on the control par el.
Press the [Q] ar Id[Q] buttons on the control par el to toggle between functions.

Press the button on the control panel to close the menu.

Repeat steps 2—4 as needed.

To play a slide show

1.

47

Connect your document camera directly to a projector or another display. For connection
information, see page 13

Set the USB switch to =8 The USB indicator 522 on the control panel is lit.
OR

Insert an SD/SDHC card or a USB drive in the appropriate port.
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3. Pressthe B button on the control panel.

Thumbnail images from the memory source are displayed.

4. Pressthe button on the control panel.
(]
5. Press the /=) button on the control panel twice to start the slide show.

6. Press the button on the control panel to stop the slide show or to return to the
thumbnails view.

To play a video

NOTE

In the thumbnails view, videos have a D symbol in the top left-hand corner of the thumbnail
image.

1. Connect your document camera directly to a projector another display. For connection
information, see page 13

2. Setthe USB switch to [*% 8. The USB indicator =¥ on the control panel is lit.
3. Insert an SD/SDHC card or a USB drive in the appropriate port.
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4. Pressthe B button on the control panel.

Thumbnail images from the memory source are displayed.

SR
5. Press the 7=\ and\i/—\l buttons on the control panel to toggle between images.

[SMRT0011.AVI
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NOTE
S—7
Press the DQQ button to pause your video.
g S—7
Press the DBQ OI’DAD@ button to adjust the volume.

= q
Press the Z—\I button to rewind and the!/—N button to fast-forward.

.

i{—nnnnnnn===if+

8. Pressthe button on the control panel to stop the video or to return back to thumbnails

view.

You can delete all images at once from your document camera’s three memory sources using the
OSD menu, or you can delete only selected images.

To delete all images

IMPORTANT

You are unable to delete images from your computer in Playback mode. You can delete images
only from the three memory sources.

1.

50

Select the memory source that you want to delete all the images from.

Press the button on the control panel to access the Playback mode OSD menu.
=
Press the l&a\! button on the control panel to select DELETE ALL.

)= =
Press the /—\) button on the control panel and then press thel&a! button again to make a
selection.

The DELETE ALL warning appears.

D= I 5
Press the /=N orlZ=\l button on the control panel to select YES or NO.
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6. Pressthe button on the control panel to DELETE or CANCEL.

7. Pressthe button on the control panel again to close the Playback mode OSD menu.

NOTE

The deleting-image icon appears briefly whilst your document camera deletes images.

To delete selected image

51

Press the B button on the control panel to display all the images in the memory storage.

)= P S (M= ()=
Press the /=X orlz2\l orla orl/=\J button on the control panel to select the image that you
want to delete.

Press the button on the control panel.
The DELETE THIS IMAGE warning appears.

)= M ¢
Press the /=N orlz=\l button on the control panel to select YES or NO.

S—7
Press the DQQ button on the control panel to DELETE or CANCEL.
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This chapter provides the information that you need to begin using SMART Document Camera as
well as SketchUp™ sketching software and Trimble® 3D Warehouse™ (formerly Google™ 3D
Warehouse).

SMART Notebook software.

3D Tools for SMART Notebook software and Mixed Reality Tools take this experience to a new
level by providing teachers and students with a new way to engage with digital 3D content.
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You can incorporate 3D content into your SMART Notebook software lessons. The following are
examples of how to do this:

o If you're teaching a biology lesson, insert a 3D model of a heart into your .notebook file.
Rotate and change the size of the 3D model to present the different parts of the heart.

o If you're teaching an English lesson, insert a 3D model of a city that is referenced in a novel
the class is reading. Enter the 3D scene to navigate streets and interiors of buildings.

o If you're teaching a primary lesson, insert multiple 3D models and use the Disguise feature
to reveal answers as a memory exercise.

Activating 3D Tools for SMART Notebook software and
Mixed Reality Tools

3D Tools for SMART Notebook software and Mixed Reality Tools provide an intuitive way for
students and teachers to explore digital content with the SMART Document Camera.

When you connect your document camera to your computer, 3D Tools for SMART Notebook
software and Mixed Reality Tools activate automatically. If you want to use 3D Tools for
SMART Notebook software on a computer that has never been connected to a document
camera, you can activate 3D Tools for SMART Notebook software by obtaining a product key
and following the procedure below.

NOTE

You can obtain a product key for 3D Tools for SMART Notebook software by registering your
document camera’s serial number at smarttech.com/register.

To activate 3D Tools for SMART Notebook software

1. For Windows operating systems, select Start > All Programs > SMART Technologies >
SMART Tools > SMART Product Update.

For Mac OS X operating system software, browse to and double-click
Applications\SMART Technologies\SMART Tools\SMART Product Update.

The SMART Product Update window appears.
2. Click Activate intheSMART Notebook row.

The SMART Software Activation dialogue box appears.
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3. Click Add.

4. Type the product key you received from SMART in the Product Key box and then clickAdd.

5. Click licence agreement, review the licence agreement and then clickClose.

6. If you accept the licence agreement, select the | accept the terms in the licence
agreement tickbox.

7. Click Next.

3D Tools for SMART Notebook software activates.
8. Click Finish and then close theSMART Product Update window.

Hardware and software requirements
To get started with Mixed Reality Tools for SMART Document Camera, you need the following:

¢ SMART Notebook software 11 SP1
¢ SMART Document Camera 450
¢ A mixed reality cube

¢ A computer meeting the requirements in the SMART Notebook software release notes
(smarttech.com/kb/170144).

Lighting requirements
Mixed Reality Tools works best in a bright room where the work surface doesn’t have any
noticeable shadows or glare.

The light must be as uniform as possible, shining on the cube and background. You can achieve
this by setting up the document camera so that the camera is facing directly down, perpendicular
to a uniform, neutral work surface. The work surface should not be darker than the black
elements on the mixed reality cube or lighter than the white elements on the cube.

NOTES

o Invery bright rooms, the work surface can appear whiter than the white elements on the
cube.

o To help increase the contrast between the cube elements and the background, and to
increase the image frame rate, you can place a piece of white paper under the cube.

A typical projector room is usually quite dark. For Mixed Reality Tools to work properly, the
document camera’s light should be tumed on. Don’t manipulate the cube more than 35cm (14")
from the document camera.
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NOTE

If SMART Notebook software doesn’t enter Mixed Reality mode when you hold the cube under
the camera, shake the cube under the camera. If the issue persists, press and hold the brighten
button % on the document camera to maximise the brightness.

To use 3D Tools for SMART Notebook software, you need to insert a 3D model in your .notebook

file. After you insert a 3D model, you can manipulate it in the same way that you manipulate other
objects in SMART Notebook software.

NOTE

You caninsert 2D images and 3D models on the same page and manipulate them the same
way that you manipulate other objects in SMART Notebook software.

Inserting 3D models
3D models are available from the 3D Objects folder in Lesson Activity Examples and the
SMART Exchange™ website (exchange.smarttech.com) as well as the Trimble 3D Warehouse
(seeUsing Trimble 3D Warehouse on page 65). You can also insert your own 3D models if they
are in one of the following formats:

o COLLADA (.dae)
o 3D Object (.obj)
e FBX (.fbx)

NOTE

Textures and other information for some 3D models are stored in separate files and folders.
When you insert these 3D models, ensure the 3D model file is located in the correct folder
structure with the supporting files and folders.

To insert a 3D model
1. Select Insert > 3D File.
The Insert 3D File dialogue box appears.
2. Browse to and select the 3D model you want to insert.
3. Press Open.

The 3D model appears on the page.
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Manipulating 3D models
Once you have inserted a 3D model, you can manipulate it in the same way that you manipulate
other objects in SMART Notebook software. In particular, you can do the following:

e Cut, copy and paste

e Clone

e Move

e Scale

e Lock

o Attach links and sounds

e Addtothe Gallery tab

NOTES
o Forinformation on these basic options, see the Help for SMART Notebook software.

o When you add a 3D model to the Gallery tab, it appears in the 3D Objects category.

In addition to these basic options, you can do the following:
¢ Rotate the 3D model
o Pause, resume, play and restart animation
o Add labels

Rotating a 3D model

You can rotate a 3D model along multiple axes. After rotating a 3D model, you can reset it to its
original orientation.

To rotate a 3D model along a single axis
1. Select the 3D model.

2. Press and hold one of the side rotation handles.

Jeorn

3. Drag your finger around the centre of the 3D model and then release your finger when
finished.

To rotate a 3D model along multiple axes
1. Select the 3D model.

2. Press and hold the centre rotation handle.

AT

o
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3. Drag your finger in the direction that you want to rotate the 3D model and then release your
finger when finished.

To reset a 3D model to its original orientation

1. Select the 3D model.

2. Press the 3D model’s menu arrow and then select Reset Rotation.

Pausing, playing and restarting animation
If a 3D model contains animation, you can pause, resume and restart the animation.

NOTE

If a 3D model doesn’t contain animation, the Animation menu documented in the following
procedures is disabled.

To pause animation
1. Select the 3D model.

2. Press the 3D model’'s menu arrow and then select Animation > Play/Pause Animation.

To resume playing animation
1. Select the 3D model.

2. Press the 3D model's menu arrow and then select Animation > Play/Pause Animation.

To restart animation

1. Select the 3D model.

2. Press the 3D model’s menu arrow and then select Animation > Restart Animation.
Adding labels

You can use labels to highlight different components of a 3D model. Labels can be text, shapes
or other 2D objects.

To add a label
1. Select the 3D model.
2. Right-click the 3D model where you want to connect the label and then select Add Label.

A label appears.

58



CHAPTER 7
Using 3D Tools for SMART Notebook software and Mixed Reality Tools

3. Tousetext in the label, double-click the label’s default text and then type your own text.

OR

To use a shape or other 2D object in the label, create the object and then drag it into the

label.

4. Optionally, drag the label's connection point to a different location on the 3D model.

To hide and display a label

1. Press the label's connection point on the 3D model.

e

The label is hidden.

2. Press the label’s connection point to display the label.

To remove a label

1. Select the label.

2. Press Close @.

Navigating 3D scenes

Large 3D models that contain internal details are called 3D scenes. You can navigate 3D scenes

using controls in SMART Notebook software.

NOTES

¢ You can use the navigation controls to navigate any 3D model. However, not all 3D
models contain internal details. If you enter a 3D model that doesn’t contain internal

details, the interior appears empty or dark.

o If you're using Mac OS X operating system software, you're unable to enter a 3D scene
while in Full Screen mode. To enter a 3D scene, first exit Full Screen mode and then

complete the following procedure.
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To navigate a 3D scene
1. Select a 3D model.
2. Press the 3D model’s menu arrow and then select Enter 3D Scene.

SMART Notebook software displays the 3D scene in Full Screen mode. A map of the 3D
scene, navigation controls and the Close button appear.

S

Close
button

Navigation

£] Tips

o You can press the grey border of the map to drag it to another area of the page if it's
covering materials that you want to present. You can also resize the map by pressing
and dragging the grey border in the lower right-hand corner.

o You can press the grey background or centre icon of a navigation control to drag it to
another area of the page if it's covering materials that you want to present.
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3. Navigate the 3D scene using the navigation controls.

¥ ey
A —

2

p

LS

i i
p "y

Use to:

Button

Change your orientation upward.

Change your orientation to the left.

Change your orientation to the right.

Change your orientation downward.

Raise elevation.

Move forward in the scene.

Move to the left in the scene.

Il oM m|Oo|lO| | >

Move to the right in the scene.

Move backward in the scene.

J Lower elevation.

Alternatively, you can use keyboard buttons to navigate the 3D scene.

Keyboard button Use to:

w Change your orientation upward.

A Change your orientation to the left.
D Change your orientation to the right.
S Change your orientation downward.
PAGE UP Raise elevation.

UP ARROW Move forward in the scene.

LEFT ARROW Move to the left in the scene.
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Keyboard button Use to:

RIGHT ARROW Move to the right in the scene.
DOWN ARROW Move backward in the scene.
PAGE DOWN Lower elevation.

ESC Close

NOTE

As you navigate the 3D scene, a red indicator in the map displays where you are in the
scene and the direction you are viewing. The arrow in the centre indicates orientation. The
arrow becomes a circle when you’re facing directly up or down.

Level Incline

I i |

olcna ]

Off-screen (level) Upward Downward

4. Press Close @ when you've finished.

After inserting 3D models in your .notebook files using 3D Tools for SMART Notebook software,
you can manipulate those models using Mixed Reality Tools for SMART Document Camera.

Manipulating 3D models using Mixed Reality Tools for
SMART Document Camera

You manipulate 3D models using your SMART Document Camera and the mixed reality cube.

To manipulate a 3D model using the mixed reality cube

1. Connect your SMART Document Camera to your computer and turn on the document
camera.

2. Open the .notebook file and then display the page containing the 3D model.
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3. Place the mixed reality cube under the SMART Document Camera, showing one side of the
cube to the camera.

[ [

SMART Notebook software enters Mixed Reality mode and assigns the 3D model to the
cube. If there is more than one 3D model on the page, move the cube until the animation on
the page indicates that the cube is connected to the 3D model you want to manipulate.

NOTE

SMART Notebook software enters Mixed Reality mode in this situation only if a 3D model
is on the page. Alternatively, you can enter Mixed Reality mode by pressing SMART

Document Camera % in the toolbar and then pressing Start Mixed Reality &/ inthe
SMART Document Camera window.

4. Do any of the following:
o Tomove the 3D model on the screen, move the cube.
o Torotate the 3D model on the screen, rotate the cube in your hand.

o Tounassign the 3D model from the cube, cover the cube’s markings with your hand.

NOTE

If you experience any of the following symptoms, the cause may be issues with tracking:
o The 3D model doesn’t connect to the cube.
o The 3D model shakes when it's connected to the cube.
o The 3D model sporadically disconnects from the cube.

o SMART Notebook software enters Mixed Reality mode when the cube is under the
camera even if you aren’t moving the cube.

To address tracking issues, see Lighting requirements on page 55.

E] Tips

o As you move and rotate the cube in your hand, ensure that you don’'t cover the
symbols on the cube’s surface.

o To hide the image from the SMART Document Camera and show only the 3D model,
move the transparency slider to the left.
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5. If you've purchased a second cube from SMART and there is more than one 3D model on
the page, manipulate another 3D model by completing steps 3 and 4 with the other cube.

NOTE

The two cubes must have different patterns if you want to use them both at the same time.

6. When you're done, move the cube (or cubes) away from the camera.

SMART Notebook software exits Mixed Reality mode after a few seconds.

Disguising 3D models before presenting them
If you want to hide 3D models in your .notebook file before presenting them, you can use the

Disguise feature to hide the 3D models with a magic hat.

When you use Mixed Reality Tools, the magic hat disappears after Mixed Reality Tools assigns
the 3D model to the cube, revealing the 3D model.

NOTE

If you hide multiple 3D models on the same page with magic hats, each magic hat has a
different coloured ribbon.

To hide a 3D model with a magic hat
1. Select the 3D model.

2. Press the 3D model’'s menu arrow and then select Disguise > Disguised.

To change the magic hat’s colour
1. Select the magic hat.

2. Press the magic hat’'s menu arrow and then select Disguise > Change Colour.

To reveal a 3D model under a magic hat

Use Mixed Reality Tools as described in Manipulating 3D models using Mixed Reality
Tools for SMART Document Camera on page 62.

After Mixed Reality Tools assigns the 3D model to the cube, stars swirl around the magic
hat, and then the magic hat disappears, revealing the 3D model behind it.

64



CHAPTER 7
Using 3D Tools for SMART Notebook software and Mixed Reality Tools

£ mip

You can also reveal the 3D model by pressing the hat & icon in the lower left-hand
corner.

You can use the following 3D tools with 3D Tools for SMART Notebook software and Mixed
Reality Tools:

o SketchUp sketching software

e Trimble 3D Warehouse (formely Google 3D Warehouse)

Using SketchUp sketching software
You can use SketchUp sketching software to create 3D models. You can save these 3D models
in COLLADA (.dae) format and then insert them in SMART Notebook software.

To save a 3D model in .dae format
1. Open the 3D model in SketchUp sketching software.
2. Select File > Export > 3D Model.

The Export Model dialogue box appears.

Browse to where you want to save the file.

Type a name for the file in the File name box.

Select COLLADA File (*.dae) in the Export type drop-down list.

o o &~ »

Press Export.

To insert the 3D model in SMART Notebook software

See Inserting 3D models on page 56.

Using Trimble 3D Warehouse

Trimble 3D Warehouse (formerly Google 3D Warehouse) is an online repository of 3D models.
Using this link in the SMART Notebook software Gallery tab, you can search for 3D models and
download them to your computer. You can then insert the 3D models into your .notebook files.

To download 3D models

1. Press the Gallery & tab,

2. Press Google 3D warehouse.
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3. Search or browse for a 3D model that you want to download.
Select the model.

4. Press Download Model and then press the Download link beside Collada (.zip).

NOTES
o When you first download a 3D model, you may be asked to provide a nickname.

o If you're using Mac OS X operating system software and you cancel the download,
the 3D model still saves to the Downloads folder.

5. Save the .zip file to your computer.

6. Extract the contents of the .zip file to a folder on your computer.

To insert a downloaded 3D model

See Inserting 3D models on page 56.
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This chapter includes troubleshooting information for your SMART Document Camera.

Use the following table to troubleshoot issues with your document camera.

NOTE

These procedures vary depending on your version of Windows operating system and your

system preferences.

Issue

Solution

The power light turns
orange in standby mode.

Press the powerQ) button again to turn it on. The power
light tums green.

No camera image displays
(Camera mode).

Ensure that your document camera is turned on.

Check all cable connections.

Check the TV/VGA switch on the right-side connection panel
of your document camera and set it to the type of display
device that you have.

Reset the output resolution to 1024x768 by using a pen tip or
other small object to press the resolution reset button on the
bottom of the document camera.

No computer image
displays

(Computer Pass-Through
mode)

Ensure that your document camera is turned on.

Check all cable connections.

Check the cable connections from the computer VGA output
to the VGA input of your document camera.

Ensure that your document camera is in Computer Pass-
Through mode.

On some laptop computers, you can press FN+F5
repeatedly to toggle between display modes and the
computer image on the presentation screen.
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Issue

Solution

The presentation screenis
dark and unreadable.

e Turn on Auto Image in your document camera’s on-screen
display (OSD) menu (Menu > IMAGE > Advanced > Auto
Image) to adjust the image brightness..

o Reset your document camera to its default settings (Menu >
SYSTEM > Default > Yes > Enter).

o Make sure that there’s enough light in the room, or tur on the
overhead light on your document camera.

¢ Adjust the brightness and contrast levels manually in the
document camera's OSD menu, or use the control panel
buttons.

o If you are using a projector, check the bulb.

The image on the
presentation screen is

e Reset your document camera to its default settings (Menu >
SYSTEM > Default > Yes).

software doesn’t detect
your document camera.

distorted or blurry. ¢ Adjust the brightness and contrast manually to reduce the
distortion.
« Press the EMputton on the control panel if the image is
blurry or out of focus.
SMART Notebook o Make sure that your USB cable is connected.

« Make sure that the USB switch is set to &%
o Make sure that your software is up-to-date (you should have

at least SMART Notebook software 11 SP1).

o Make sure that the USB cable and the computer USB port
are working properly.

o Make sure that the USB to PC setting is set to CAMERA in
the document camera's OSD menu.

SMART Notebook
software enters Mixed
Reality mode
unexpectedly.

=,
o Press SMART Document Camera =% in the toolbar.

o Press Additional Settingsél-@. and then clear the selection
of Automatically Start Mixed Reality Tools.

KN NOTE
To enable the automatic detection of Mixed Reality again,

press Additional Settings@. and then select
Automatically Start Mixed Reality Tools.

No image appears when

you press the B button.

o Insert an SD/SDHC card or USB drive with stored images,
or capture an image to the embedded memory.

NOTE

Images need to be stored in the available memory location
in order to enter Playback mode.

e Disconnect the USB cable or set the USB switch to .
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Issue

Solution

Your document camera
doesn't detect the inserted
USB drive.

Ensure that the USB switch is set to [~<E.

You're unable to record a
video (the red recording
light doesn’t tum on).

e Ensure that an SD/SDHC card or USB drive is installed.

o Disconnect the USB cable (the document camera doesn't
record video whilst being used as a USB camera or mass
storage device).

The SD/SDHC card or
USB drive doesn't play
video properly, or the
document camera stops
responding during video
recording.

Format the SD/SDHC card or USB drive using the document
camera's OSD menu (Menu > SETTING > Format > SD
CARD / USB DRIVE).

'Y CAUTION
This erases all the data on the SD/SDHC or USB drive.

Your document camera
has an issue not described
above.

|
Restart the document camera using the power button on
the control panel.
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Appendix A

Hardware environmental
compliance

SMART Technologies supports global efforts to ensure that electronic equipment is
manufactured, sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment regulations apply to all electrical and electronic
equipment sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART Technologies
products, we strongly encourage you to properly recycle the electronic product when it has
reached the end of its life. If you require further information, please contact your reseller or
SMART Technologies for information on which recycling agency to contact.

This product meets the requirements of the European Union’s Restriction of Certain Hazardous
Substances (RoHS) directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in various
geographical areas and that reference the European Union’s RoHS directive.

Many countries have regulations restricting the use of certain heavy metals in product packaging.
The packaging used by SMART Technologies to send products complies with applicable
packaging laws.
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